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Elementary and Secondary Schools

Elementary and Secondary schools will follow the steps in this handbook to:

e Run the Federal Survey Form Report in PowerSchool
e Create a spreadsheet using Microsoft Excel

e Use mail merge to create labels
e Collect and track Federal Survey Forms

e Submit forms and report to Impact Aid Office

Run the Federal Survey Form Report on the Survey Date

1. From the Start Page in PowerSchool, select System Reports.
2. Select SDUSD tab.
3. Select Federal Survey Form Report.

Functions

Attendance

Daily Bulletin @
Enroliment Summary
Master Schedule
Dashboard

Special Functions
Teacher Schedules

Reports

System Reports
ReportWorks

People

Student Search
Staff Search
Parent Search
Enroll New Student
New Staff Entry
New Parent Entry

Setup

School
System

4

SDUSD Custom Reports

System ReportWorks State Engine Setup Enterprise Reporting SDUsSD sqlReports 4

Report
Attendance Code Counts

Attendance Roster
Eligibility Report

English Learner Chart
English Learner Export
Enroliment Counts Chart by

Grade Level or Class Of

Enroliment Map

Federal Survey Form Report i

Gains and Losses Audit

2

Description
Listing of students and their Attendance Code Counts

Weekly attendance roster with signature line for use by substitutes for taking
attendance.

Report of students eligible to participate in extra curricular activities.

Chart showing the number or percentage of English Learners enrolled at your
school. Please note that this report will only include actively enrolled students
at your school, in Grades K-12

Report to create a CSV file listing students with the English Learner Special
Program.

Chart showing the number of students enrolled at your school, by Grade Level
and/or Class Of.

Map showing students enrolled at your school, by Grade Level, Zip Code, or
other criteria.

Creates Tracking Excel sheet for Federal Survey Form.

Audit Report showing students entering and exiting Grades and Special
Programs.
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4. Follow instructions below for your site level:

Elemeniary Example Leave meetings unchecked. Do not change date. Click Submit.
Federal Survey Form Report

Report Name Federal Survey Form Report
P Y ? Elementary
Version Leave Meeting(s) .
unchecked. Schools:
Description king Excel sheet for Federal
Do NOT change S Just click
date.
Comments t Periods to print Submit.
Meeting(s) (leave 1RE
unchecked for all) 1T 0
Effective date: 10/03/2018

Secondary Example Select the period for which you would like the report to run and then
click Submit. For example, your site may decide to collect the survey forms during Period 4. In this case,
you should select 4.

Federal Survey Form Report
Report Name Federal Survey Form Report
Version 2.0
Description Creates Tracking Excel sheet for Federal Survey Forms
Comments Please select Periods to print
Meeting(s) (leave unchecked for all) A
1 O
2 - ’ Secondary ‘
3 O Schools:
Select the period
: v | i1 survey forms
5 m will be collected.
e - Then click
7 m| Submit.
8 O
Effective date: 10/03/2018
Date is
preset.
Do not
change. m
(Your meeting options may look different.)
PowerSchool
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K-8 Example: Most K-8 sites will need to select a period for their secondary students (such as
Advisory), and one for their elementary students. Select the period(s) for which you would like the report
to run and then click Submit.

Federal Survey Form Report

Report Name Federal Survey Form Report

Version 2.0

Description Creates Tracking Excel sheet for Federal Survey Forms
Comments Please select Periods to print K-8 Schools:

Meeting(s) (leave unchecked for all) A B tshe;e;tj rt‘:]eey F;s::::g
1 . . are collected.
5 O O Check one

period for

3 m v/ elementary and
4 O O — one for

secondary.
5 i i
6 O O Click Submit.
A O O
E O M

Effective date: 10/03/2018 -

el

(Your meeting options may look different.)

5. After clicking Submit in Step 4, a dialog window opens.

Verify or Click Open with.

Opening FederalSurveyFormReport.csv “

You have chosen to open:
El-| FederalSurveyFormReport.csv
which is: Microsoft Excel Comma Separated Values File
from: https://powerschoaltrng andi.net
What should Firefox do with thi

h | Microsoft Excel (defautt v'l

() Save File

O Do this automatically for files like this from now on. ,

OK | Cancel

(Your options may look different)

PowerSchool
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4. Click OK. The Excel file opens.

5. In Excel, click File, then click Save As.

Home Inser|

= Save
Bl save As

.7 Open

" Close

(Your options may look different)

6. Browse to the location in which you want to store the file. Some users like to first create a new
folder, titled Federal Survey Forms for example, to store this report and other related files.
Name the file to FedSurveyFormReport1819 cost center.xls where “cost center” is your 2018-
2019 cost center. For example, if your cost center is 0357, your file should be titled,
“FedSurveyFormReport1819 0357”. Select Excel Workbook in the ‘Save as type’ field.

Save As E
"E—) = 4 | » ThisPC » Documents v & Search Documents P
Organize « MNew folder Bz - [7]
Microsoft Excel MName Date modified Type Size Lo
I Favorites
B Desktop
& Downloads
1 Recent places
1% This PC
o
i Desktop
| Documents
4. Downloads o
] FederalSurveyCardReport1819_0357
File name: — I v
ISave as type: | Excel Workbook Ivl
Authors: Wim Mo Tags: Addatag Title: Add a title
[[]Save Thumbnail
= Hide Folders Tools = Cancel

7. Click Save.

PowerSchool
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8. If this prompt appears, click Open.

The FedSurveyCardsl  |_cost center.xls download has completed. Open folder View downloads

9. If any cells contain “ #H#H##H#”, you must expand the column width to see the data.
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Format the Federal Survey Form Report in Excel

Header/Footer and Page Set Up of the Report

1. Open your saved Excel report for the Federal Survey Form.
Click the Page Layout tab > Margins > Custom Margins (the words at the bottom, not the icon.).

a. On the Page tab, click the Landscape radio button.

%}" Page Setup

-

Page Margins Header/Footer Shee

Orientation

) Portrait

b. On the Margins tab, set Left and Right to .25.
Toptol
Bottom to .5
Header to .5
Footer to .25

c. On the Header/Footer tab, click Custom Header

d. Inthe Center section, enter the following: 18/19 Federal Survey Form Report. Press
the Enter key on your keyboard, and then enter your School name and your location #.

For example:

Header

Header
To format text: select the text, then choose the Format Text button. Enter date)
To insert a page number, date, time, file path, filename, or tab name: position the title School

insertion point in the edit box, then choose the appropriate button. !
To insert picture: press the Insert Picture button. To format your picture, place the name and

cursor in the edit box and press the Format Picture button.

school
Al B@ o &8 location
Left section: i number.
18/19 Federal Survey Form )
Report

Loc#1234

Sample Elementary School, ‘

Cancel
e. Click OK. (This window closes and returns to the Header/Footer tab on the Page Setup

dialog box.
f.  Click Custom Footer (the cursor will be in the Left section)

PowerSchool
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2 3

Click the Insert File Path icon .

(&[Path]&[File] appears.

In the printed document, this will show the file path and name. )
Click in the Right section.

Click the Insert Page Number icon, type the word of, press the space bar, and then

click the Insert # of Pages icon. (This will put page numbers (e.g., 1 of 16) on your
report.)

Click OK.
Click the Sheet tab:

In Rows to Repeat at Top, enter Al. (This will put your column headers on all pages.)

Check Gridlines to include gridlines in the spreadsheet.
Click OK.

Your window should look like this:

Page Setup

Page Margins | Header/Footer =~ Sheet

Print area: S
Erint titl
| Rows to repeat at top: Al 3

Columns to repeat at left: B

Print
[+] Gridlines

Comments: {None} v
- Cell grrors as: | displayed w
[] Draft guality = Pl
[[] Row and column headings
Page order
(@ Down, then over
() Over, then down
Print...

Required: Select All Borders for Gridlines in Report

1. Click the triangle to the left of the A cell. The entire Excel report will turn gray.

H o Q-
HOME IMSERT PAGE LAYOUT FORMULAS DATA
Colors - W [N (|
e | 0% 1D G
) 5 1D L e
Theres Margins Orientation Size  Print  Breaks Background
- D Effects = - - *  Arear v
Themes Page Setup
AL - Jr | enrmr
A B C D E F G
RMT Last Nam|First Nan|Address |City
2 1 Barrera |Yahir 4391 CLA|SAN DIEG
3 1 Jibril 3403 IDLESAN DIEQ
4 1 Bess Suhayb 4625 NOGSAN DIEG
5 1] Bourque|Khanh  |4340 MOJSAN DIEG
6 1 Castro  [Asa 3402 ELSI|SAN DIEG
7 1 Cerezo |Kalvin  |7306 FUL|SAN DIEG
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2. Then, in the Home tab, click the Borders icon and select All Borders from the menu.
This will put gridlines throughout your report including the Missing Form column.

ENRMT [MISSING

i orde
All Borders -
Bou,qu"m—wm-n—lu Tide porders i

Castro | [Z] Thick Box Border

|SENEGE i Bottom Double Border

hick Bottom Border

op and Bottom Border

op and Thick Bottom Border

Leyva i Top and Double Bottom Border

BRI (/o Borders

Lopez €

o L = T T TR T R R N N TR N

Lovio ET Draw Border

Mottas [ Drow Border Grid

3. Click Save and close the file until you need to use it when students turn in their forms.

OME

Q-

INSERT

PAGE LAYOUT FORMU

A A
Click Save |
Clipboard i
| then close
Al h
the file.

4 A B F
1 |ENRMT |MISSING ﬁrrAddr
2 1 Barrera |Yahir 4391
3 1 Bergman|Jibril 3403
4 1 Bess Suhayb |4625
5 1 Bourgue |Khanh 4340
6 1 Castro  |Asa 3402
7 1 Cerezo |Kalvin  |7306
8 1 Coe Carys 3735
9 1 Favela |Ellis 4715
10 1 Hasley |Elin 5027
11 1 Lo Chaca AzJ0

"

Reminder! The Federal Survey Form Report is created
to automatically tally your survey form counts as you

enter them in the Have Form and Missing Form cells.
You will see the sum at the bottom of each column.

PowerSchool
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Run Labels for the Federal Survey Forms

Labels must be attached to the survey forms before they are sent in to the Impact Aid Office. You must
run the labels from your PowerSchool Federal Survey Report. Run the labels when you prepare for the
survey, and set them aside. You may wait until forms are completed to attach the labels since you may not
know what language form each child needs. Please affix the label in the blank_upper_right area of the
survey forms without covering any of the print.

These labels assist the central office to identify the students since some handwriting is unreadable and we
are dealing with a high volume of forms. Also, the name written on the forms is not always the registered
name, which makes it hard to find in the student information system.

Create Labels Using Mail Merge in Word

10.

11.

Launch Microsoft Word.
Click the Mailings tab

Click Start Mail Merge > Select Step by Step Mail Merge Wizard ...
The Mail Merge task pane opens on the right side of the document:

Under Select document type, click the Labels radio button
Under Step 1 of 6 at the bottom of the page, click Next: Starting document.

Under Change document layout, click Label options and select the types of labels you are going to
print. (Typically Avery 5167, but the type of labels you have could be different.)

Click OK.
Under Step 2 of 6, click Next: Select recipients.

Under Select recipients, confirm that the Use an existing list radio button is selected, and under
Use an existing list, click Browse....

When the browse window opens, navigate to your desktop, and select the Excel Spreadsheet that you
saved earlier, “FedSurveyFormsXX cost center of your site.xls”

Click OK
The following (or similar) window opens:
Select Table [
Mame Description  Modified Created Type

12:00:00 AM  12:00:00 AM  TABLE

4 (L I

First row of data contains column headers [ Ok l I Cancel I

.

(If more than one row is listed in the Select Table window, select the top option)
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12.
13.

14.
15.
16.
17.

18.

19.

20.

21.

22.

23.
24,
25.

Confirm that First row of data contains column headers is checked.

Click OK.

The Mail Merge Recipients window opens:

Click OK.

You should now see the label sheet formatted with the words Next Record appearing in each label.
At the bottom right, under Step 3 of 6, click Next: Arrange your labels.

Under Arrange your labels, click More items ... .

The Insert Merge Field window opens. The fields listed match the fields found in your Excel
spreadsheet.

Insert the desired fields from the list.

You must include Last Name, First Name, and Student ldent.

(You could also add Teacher Name or Classroom Number if you will be distributing forms by teacher
or classroom.)

Close the Insert Merge Field window.

Edit the label information:
You can add spaces (or commas and spaces) between each field, or hit the Enter key on your
keyboard to add a new line after any field.

Select All and change the font size to have the text better fit your label. (Most users choose 8 or 9
point).

Click the Update all labels button.

(This changes all the labels to match the first one you formatted.)

Under Step 4 of 6, click Next: Preview your labels.

Under Step 5 of 6, click Next: Complete the merge.

IMPORTANT: To print all labels, click Print... in the Mail Merge box on the right side of the
screen.

’:: Mail Merge v X

-~

Complete the merge

Mail Merge is ready to produce
your mading labeils,

To personalize your lab
"Edit Individual Labels
open a new doc
merged labels. To
to all the labels, s
the original dog

Merge

(If you were to choose Print from the File menu, only the first page of labels would print.)

PowerSchool
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Track Survey Form Collection Using Report and
Labels

As forms are turned in by your teachers:
1. Affix the corresponding label in the blank upper right area of the survey form without covering
any of the print.

2. Open your Excel Federal Survey Form Report and Type the numeral 1 in the HAVE FORM
column for each student with a completed form. If you have duplicate forms for a student, staple
these together and count as one.

3. If the student does not have a form, enter the numeral 1 in the MISSING FORM column.

Note any student name changes on the form and put the form in alphabetical order according to your
list. For example, if student name “David Smith” is on your report and the label, however “David
Jones” is now written on the form, due to name change, please highlight “David Smith” on your
report and write “David Jones” next to the name on the report. On the form, write “David Jones”
above the name on label. You can file it by Smith for comparison purposes to balance your forms to
your list.

Add Sort & Filter Function

While recording your form collection, you may sort the list by teacher, classroom number, or student
ID number. It is suggested to keep your list in classroom or teacher order until the end of your survey
form collection.

1. To apply the Sort & Filter:

FederalSurveyCardReport1718_schoal® - Excel ? H /0%

Click

FORMULAS DATA REVIEW VIEW ACROBAT

CY L . = = A

P ! 2 - o c I Sort & S I [l;i]&

aste - » €0 .00 onditiona - ort in

- v - e Formatting Fllter T = 7| Filter = felect -
Clipboard & ] Number ] 2l SotAtoZ ~
Prat Titles ~ | i Al setZioa v
B F 1 -

1 |[ENRMT |MISSING CA” “Name First Name [Address | Birthdate  |Student Ideg

2 &3 ; Yzhir 4391 CLAIREMONT MESA BLVD [ s/1/z2009] )

3 Y{ Click #1 n Jibril 3403 IDLEWILD WAY 4 .

4 1 cell to Suhayb _ |4625 NOGAL ST Click 3

5 1 . . e Khanh _ [4340 MORAGA AV, APT 4 - | se1164 3

6 1 hlghllght Asa 3402 ELSINORE PL Filter ] 530706 3

7 1 Kalvin 7306 FULTON ST, UNIT 1 ey < saz51 3

8 1 column carys 3735 SOUTHVIEW DR, APT 311 10/1/2008 509838 3

9 1 header row. Ellis 4715 CLAIREMONT MESA BLVD, APT 504 2/1/2009 536645 3

10 h | fl Elin S027AMOUNT HABRIS DR al1/20n9 524142 3

S
To use the filter, click on the dropdown arrow in the column title you wish to work with. Make the
selections you wish to display by selecting or deselecting. Click OK.
PowerSchool
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Reminder! The Federal Survey Form Report is created to automatically tally your survey form
counts as you enter them in the Have Form and Missing Form cells. You will see the sum at the
bottom of each column. Please confirm the totals match your form collection count. If not, check to
be sure the formulas are still calculating. If you have any problems, please call for assistance before
submitting the final report to the Impact Aid Office.

PowerSchool
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Finalize the Report to Submit

Count and Alphabetize Forms

At the end of the collection,

« You must alphabetize all of your forms in complete alphabetical order.

« Count all of your forms. Your total on your list should match the number of forms collected. If it
doesn’t, go through the forms, comparing them to the list until you are balanced to your list.

Required Report Columns List

1. Your final report must ONLY include the following columns:

ENRMT
MISSING FORM
HAVE FORM
Last Name

First Name
Address
Birthdate

STUDENT Ident
Grade Number

a. Hide or Remove the columns, City, Zip, Teacher, Room #, Period, Course Code and
Course Description columns when actually submitting the report. (This will reduce the
number of pages of your report)

To hide columns follow the two steps below:
H |
b Cut ate |
DIES o ory g
oo , 1/24
[y Paste Options: ﬁ
Right click v 2 1/20
on C0|umn Paste Special... ﬁ
letter. . 1
Insert ﬁ
. i Delete ﬂ
N DIEG Clear Contents ﬂ
San Diegt Format Cells... ﬁ
h Column Width... ﬂ
SANDI 1/2d
SAN DIEG Unhide 1/20

b. Click View tab and select Page Break Preview.
Move the blue lines to include the 9 required columns (see list in #1)

PowerSchool

Federal Survey Form Report Handbook e Page 16



1

San Diego Unified

SCHOOL DISTRICT

Use Sort & Filter Function to Sort Data by Student Last Name

o
IMPORTANT! Your final report must be sorted by

student last name, for the entire school
before submitting to the Impact Aid Office!

If you have not added the filter function, follow the steps below:

H B FederalSurveyCardReport1718 _school# - Excel v ol S
RT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  ACROBAT Click -
L= — = _.' A
D - Calibri EF General - SOI‘t & Y H
Paste B I == . - 95 s | &2 oo | Conditional . Sort & Find &
- & E $ e Farmatting FI Iter Filter = Jelect -
Clipboard & [} Number [F §l SortAtoZ ~
Prigt Titles ~ Zl SortZtoa v
E F 1 i
1 [ENRMT | cy “\ame First Name |Address | Birthdate _|Student Ideg I
2 ¥ r ; Yahir 4391 CLAIREMONT MESA BLVD [ 5/1/2009]
3 Click #1 Jibril 3403 IDLEWILD WAY . |
4 1™ cell to Suhayb 4625 NOGALST Click 3
5 1 . . Khanh 4340 MORAGA AV, APT 4 A 561164 3
6 1 h|ghl|g ht Asa 3402 ELSINORE PL Filter 530706, 3
7 1 column Kalvin 7306 FULTON ST, UNIT 1 rrr 542251 3
8 1 carys 3735 SOUTHVIEW DR, APT 311 10/1/2008| 509838, 3
9 1 header row. Ellis 4715 CLAIREMONT MESA BLVD, APT 504 2/1/2009 536645, 3
10 1 Elin, SO2ZAQLINT HARRIC DB 2/1/2009) 524142 3

| —

When the filters are applied:

1. Click on the filter arrow in the Last Name column.

2. Clickon Sort Ato Z.

INSERT ~ PAGELAYOUT ~ FORMULAS  DATA

< - v =
i Calibri Jn A A ==
Bz Copy -

aste I Ee P P
 Format ainter | © 1 Y H-A- === |4
Clipboard ] Fant

D2 i f‘

5
Barrera
D ro E

A B
1 |Enrml~ |missing cad < |ua: D [~[tastname | [=|firstna
2 1 |20 senat Yahir
3 1 Zl SotZioh Jioril
& 1 Sort by Color , [Suhayb
5 1 Khanh
6 1 Asa
7 1 Kalvin
8 1 Text Filters » |carys
9 1 Ellis
Search
o 1 o #letn
¥ (Select All N
1 1 g etect Chase
h2 1 lAba Porfirio
B 1 MAloese Tristan
14 1 P alonzo Anthon
[l Alshamman
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3. Then click OK.
Look over your report data to be sure it is in the appropriate order.

PowerSchool
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Record Your Information on Bottom of Report
4. Before printing, type your name, phone number and e-mail address at the bottom of the report.
5. Print one copy of the list in Landscape format on 8 1/2 x 11 paper.

If your report is too wide, please reduce the size of your report from Page Layout tab:

@ = 1
HOME  INSERT MULAS DATA
B colors - v [ ==
e @B D

VIEW ACROBAT

[ EWidth: 1 page -

3

1 H flght: | Automatic -
hemes Margins Orientation  Size  Pri AdJUSt to .
- D Effects ~ - - - Arel 1 page
Themes Page Sef Scale to Fit [F]

6. On the last page of your printed report, Circle the total number in the HAVE FORM column.
7. Sign and date the printed report.

Example:
1 1|Urias Harry 4512 CLAIREMONT DR, 1/2 1/1/2011 587332 1
1 1|Van Leela 3320 VIA BARTOLO 10/1/2007 533297 5
1 1|Vicencio Quinton 3233 Karok Ave 8/1/2010 446199 1
1 1|Viramontes Ginger 6423 Mount Ackerman DR 12/1/2009 548687 2
1 1|Vorise Vladimir  |5649 Market Street, Street 2/1/2008 604475 4
1 1|Weddle Joceline 3735 SOUTHVIEW DR, APT 311 4/1/2011 570297 1
1 . . Elliott 8036 LINDA VISTARD, APT 2H 5/1/2007 604466 4
1 Circle the total in  Taian 3530 IDLEWILD WAY 11/1/2011 564915 0
1 the Have Form Emiliano 3437 MOUNT ARIANE DR 5/1/2009 537783 3
1 column Harun 3888 GENESEE AVE, APT 113 4/1/2009 528250 2
1 James 4569 CLAIREMONT DR 4/1/2009 415065 3
1 — \ [yan Italia 4146 RAPPAHANN 566071 1
1 1|Zamorano Nestor 4079 HUERFANO H 528240 3
1 \\ Ill Zamorano Starr 4441 MORAGA AV| Sign and Date report. 414147 3
1 Zipp Nevin 3511 IDLEWILD WA - =y 528263 3

159 1 (158 A
==

Staff member responsible for survey: Suzie Seals f«zfa xﬁ’;aﬁf October 20. 2018

Email: sseals@sandi.net

Phonett: (858)291-1234

8.

Submit Completed Report and Forms

1. Submit the original and keep a copy with the site employee information, signature and circled
total on file at the site until the end of the school year. Also keep the electronic file until the end
of the school year.

2.  When submitting the report and the actual survey forms, bring them to the Impact Aid Office,
Room 3244 at the Education Center.

Please contact the Impact Aide Office with any Federal Survey Form questions.

4. If you encounter PowerSchool-related problems, please contact your school’s PowerSchool
Power User or the IT Help Desk at 619-209-HELP (4357).

PowerSchool
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Sample Page of Federal Survey Form Report

18/19 Federal Survey Form Report
Sample Elementary School, Loc#0123

ENRMT | WISSING FORM HAVE FORM Last Name First Name |Address Birthdate Student ldent  |Grade Number
1 1[Tims Alexander 2635 DEERPARK DR 9/1/2007 387045 5
1 1[Tom Donell 2552 IMPERIAL AVE 10/1/2011 570723 0
1 1[Tompkins Valorie 3497 ACCOMAC AV 5/1/2010 444202 2
1 1|Torres Garcia Genesis 3124 COWLEY WAY, APT 2____._..-—-—""'"'-.-_ b09 524708 2
1 1|Urias Harry 45 I 587332 1
1 ifvan o7 533297 5
1 PE—— 0 rt o 446199 1
1 \ e e p % 548687 2
1 \‘ S a m p format 'ﬁ 604475 4
1 e for n 570297 1
1 \ LandscaP ly the columns show i 604466 4
1 \ \nc'lude on Y{’Z <11 paper | 564915 0
1 \ Print on 81 5/1/2009 537783 3
1 \ I AVE, APT 113 4/1/2009 528250] 2
1 \ e lAfes  |4565 CLAIREMONT DR 4/1/2009 415065 3
1 [Van_ Italia 4146 RAPPAHANNOCK AVE 5/1/2011 566071 1
1 1[zamorano Nestor 4079 HUERFANO AVE, UNIT 102 7/1/2009 528240 3
1 1|zamorano starr 4441 MORAGA AVE 12/1/2008 414147 3
1 Zipp Nevin 3511 IDLEWILD WAY 1/1/2009 528263 3

159 1 { 1s2

Staff member responsible for survey: \_-‘guzie Seals Sz Seatk October 20, 2018

Email: | | sseals@sandi.net

Phonet: | [ (858)291-1234

\\PRDECHOME16\16\163\163876\Deskiop\ FederalSurveyFormReport1819_schoolk# Sof 5

Screenshot shows final page of report. Print and submit ALL pages of your school’s report.
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“Vt San Diego Unified

SCHOOL DISTRICT

Additional Report to Submit: Special Education

— SAl Services

Run the Special Education-SAl Services report in PowerSchool. You will print the report and attach
your Principal’s Certifications. This report needs to be included in your submitted documents to the

Impact Aid Office.

1. From the Start Page in PowerSchool, click System Reports.

2. Click sglReports4 tab.
3. Expand Enrollment reports.

2% PpwerSchool

Start Page
=2
- 4
Functions

sqlReports

Attendance

Daily Bulletin
Enroliment Summary
Master Schedule
Dashboard

Special Functions
Teacher Schedules

Reports
System Reports

System ReportWorks

Report

+ Attendance

ReportWaorks * Behavior

» CALPADS
People

* District
Student Search i

¢ Early Childhood
Staff Search

» English Leae

Address Errors

Parent Search
Enroll New Student
New Staff Entry
New Parent Entry

Setup

Class Of List

Alpha Roster with Teacher and Room

Welcome, Karisma Rae Tribble Help Sign Qut

School: Baker Elementary Term: 18-19 Year

State Engine Setup Enterprise Reporting SDUSD

sqlReports 4

Create a new sglReport - Import a new sqlReport

Expand All Collapse All

Title

Address Errors

Alpha Roster with Teacher and Room

Class Of List

4. Scroll down the list and click Special Education-SAl Services report.

T TTOTOT Y TO SO TV IS U TR S TE eSS TTTTOTTTTRITOTT
Portal Access for Parents and Students

Special Education - Case Manager Dgt;

Special Education - SAl Services

Special Programs - Cal-SAFE

Special Programs - EL, Gate, Special Ed
Special Programs - English Learners

Special Programs - Gate Students

Cnosial Dronram (=Y Cd4d STADC

Portal Access for Parents and Students
Special Education - Case Manager Data
Special Education - SAl Services

Special Programs - Cal-SAFE

Special Programs - EL, Gate, Special Ed

Special Programs - English Leamers

Special Programs - Gate Students

Snocial Dronrom on CAdCTADC
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5. Set the Effective Date to 10/3/2018. Then click Submit.

Run sqlReport -

Label Value
Name Special Education - SAl Services
Description This report lists students with di

Effective Date |10/3/2018

Effective

10/3/2018

5 receiving specialized Academic Instruction (SAl) services.

Set

Date
to

The report data will display in PowerSchool. Use the print icon to print page(s) of the Special

Education-SAl Services report.

3% PowerSchool

frt Page - sqglReports = Run sglReport
=2
. “
inctions

Special Education - SAl Services

endance

ily Bulletin
rollment Summary
ster Schedule
shboard

ecial Functions

Parameters - Effective Date: 10/3/2018

Welcome, Karisma Rae Tribble Help Sign Out

School: Baker Elementary  Term: 18-19 Year

Click on print icon ff

to print report.

stem

Search:
fcher Schedules SCHOOL LAST FIRST STUDENT GRADE PRIMARY
IEPDEVDATE PRISPSERVICEC PROGRAM
Eports NAME NAME NAME NUMBER LEVEL DISABILITY
Baker Akbar Serina 449340 5 Specific 05/09/2018 3300 Spec Ed
stem Reports _
Elementary Learning Services
orViOES Disability (SLD)
kople Baker Bazan Marlon 584708 0 Autism (AUT) 03/22/2017 3300 Spec Ed
Elementary Preformal
dent Search B
[ — Baker Bracken Demetri 608172 4 Specific 05/11/2018 3300 Spec Ed
Elementary Learning Services
ogisealch Disability (SLD)
roll New Student
Baker Braithwaite  Quenton 574654 2 Autism (AUT) 11/16/2017 3300 Spec Ed
w Staff Entry
e iy Elementary Services
Baker Brenner Ulysses 543188 3 Autism (AUT) 02/27/2018 3300 Spec Ed
etup Elementary Services
hool Baker Brucker Aniyah 400126 5 Specific 02/15/2018 3300 Spec Ed
Elementary Learning Services

Disability (SLD)

Submit this report, along with the Federal Survey Form documents, to the Impact Aid Office.
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